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Word 

Tip Technique 

Quick Zoom [Ctrl] + Scroll wheel on mouse 

Reveal Formatting Yes, Word can reveal the details of the formatting 
used in your documents. It still doesn’t look like 
WordPefect’s reveal formats, but works. 

 Press  for hidden characters 

 Press [Shift] [F1] (Word 2003 & Word 2007) 

 Choose Format, Reveal Formatting (Word 2002) 

Format Paint  Highlight text containing format to duplicate 

 Click Format Paint tool  on toolbar 

 Highlight text to apply format 

Repeat format paint 
(provided by PACS 
member) 

 Highlight text containing format to duplicate 

 Double-click Format Paint tool  on toolbar 

 Highlight text to apply format as many times as 
desired 

 Click Format Paint tool  on toolbar to stop 

Smart-Tags  When you see a word or phrase underlined with 
purple dots, right-click to show options 

 When you see the smart-tag  symbol, click 
the drop down arrow to show options 

Add a line without a bullet 
in a bulleted list 

In a bulleted list, new lines automatically get a bullet 
 

 Press [Enter] to start a new paragraph 

 Press [Backspace] to remove bullet 
or 

 Press [Shift] [Enter] to create a line feed in the 
same paragraph 

 
Remember all paragraph formatting (indents, tabs, 
etc.) are actually contained in the ¶ symbol at the 
end of the paragraph. The first technique creates two 
paragraphs can be formatted independently while 
the 2nd technique only creates one paragraph with 
two lines. 
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Word 

Tip Technique 

To type special symbols: 
© 
® 
™ 
 
 

Override to show raw 
characters 

Type: 
  ( c ) 
  ( r ) 
  ( t m ) 
- - > 
= = > 

Press [Backspace] to revert conversion back to 
typed characters 

Add the calculate 
command to the toolbar 
 
 
 
 
 
 
Add an icon to the button 
 
 
 
 
Just show the icon 
 
 
 
Add a vertical line 

 Right-click any visible toolbar 

 Select Customize… from the menu 

 Select the Commands tab 

 Highlight Tools in the Categories: list 

 Drag & drop Tools Calculate from the Commands: 
list to the desired toolbar 

 

 Right-click the Tools Calculate button on the 
toolbar 

 Select Change Button Image from the menu 

 Select the icon to use on the toolbar 
 

 Right-click the Tools Calculate button on the 
toolbar 

 Select Default Style 
 

 Drag & Drop the Tools Calculate button one half 
button distance to the right to add a vertical line 

 

 Click the Close button to finish 

Do quick calculations in a 
document 

 Type the desired equation 

 Highlight the equation 

 Click the Tools Calculate button which will put the 
result in the clipboard and in the lower left of the 
status bar 

 Press [Ctrl] V to paste the result back into the 
document 
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Word 

Tip Technique 

Save All menu  Hold [Shift] key and click File menu to reveal the 
Save All menu choice which saves all open 
documents 

Jump to last changed 
item 

 [Shift] [F5] will move the cursor back to the last 
changed item in the document 

Draw paragraph lines: 

 

 

Override to show raw 
characters 

Type: 
- - - and press [Enter] 
_ _ _ and press [Enter] 
= = = and press [Enter] 

 Press [Backspace] to revert conversion back to 
typed characters 

Move through the 
document 

 Click the Select Browse Object button at 
the bottom of the vertical scroll bar 

 Select the desired movement increment 

 

Work on two different 
sections of the same 
document at the same 
time 

Drag & Drop the document split, found at 
the top of the vertical scroll bar, half way 
down the screen  

Non-break [space] and 
[hyphen] 

Normally the [space] and [hyphen] characters will be 
used to wrap a line of text to the next line. But if you 
want to keep both parts of a name or hyphenated 
phrase together, use a non-break [space] or 
[hyphen] 

 [Ctrl] [Shift] [space] 

 [Ctrl] [Shift] [hyphen] 

Multiple selections  Select the first block of text 

 Hold the [Ctrl] key down and select more text 

 Repeat for as many selections as desired 

 All formats will be applied to all of the selections 
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Word 

Tip Technique 

Multiple highlights 
(thanks to Jim 
Powell and the 
Office Letter:  
www.officeletter.c
om) 

Rather than highlighting one block of text at a time, treat the 
highlight tool and you document like you would have used a 
highlighter in a regular document: read and highlight 
without returning to the toolbar each time. 

 Choose the highlight color you want using the dropdown 

arrow next to the highlight tool  on the toolbar 

 Click the highlight tool again – this will keep the button in 

a depressed state  

 Highlight desired blocks of text 

 Click the highlight tool again to turn off the highlight mode 

Formatting with 
the Ruler Bar 

The dialog boxes under the Format menu provide precise 
control of margin, indent, and tab settings, but using the 
Ruler Bar 

provides instant feedback. 

 Highlight the lines to be formatted 

 Adjust first line , remaining lines , or right  indent 

 Click the button on the far left of the ruler bar to add 

left aligned , center aligned , right aligned , or 

decimal aligned  tabs. Click the location on the ruler bar 
where the tab should be added. Drag & drop a tab to 
adjust it’s location. Drag & drop a tab up or down to delete 
the tab. 

 Adjust the left  or right  margin 

Rearrange 
paragraphs 

To swap the order of two paragraphs 

 Highlight the paragraph to be moved 

 Hold the [Shift] and [Alt] keys 

 Press the [Up] or [Down] arrow key to move the 
paragraph 

Insert a page 
break 

 Press [Ctrl] [Enter] 
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Word 

Tip Technique 

Change text case (Word 2003) 

 Highlight text 

 Press [Shift] [Ctrl] [a]  
 
(Word 2007) 

 Click the Change Case button  on the Home Ribbon 

 or press [Shift] [F3] to cycle through options 

Footnotes (Word 2007) 

 Position cursor where you would like the 
footnote to appear 

 Click the Insert Footnote button on the 
Reference Ribbon 

 Repeat for additional footnotes 

Bibliography (Word 2007) 

 Position cursor where you would like the 
citation to appear 

 Click the Insert Citation button on the 
Reference Ribbon 

 Repeat for additional citations 
 

 Position cursor where you would like to insert the 
bibliography. 

 Choose the bibliography style  from 
Reference Ribbon. 

 Click the Bibliography button  on the 
Reference Ribbon. 
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Excel 

Tip Technique 

Insert live, stock 
information 

 Type the stock symbol into a cell and press [Enter] 

 Click the Information smart tag  

 Select the information to be inserted based on the 
stock symbol 

Zoom to fit  Highlight the cells which will fill the screen 

 Click the dropdown arrow on the Zoom tool on the 
toolbar 

 Select the Selection option on the dropdown list 

Format with currency  Highlight the cells to format 

 Press [Ctrl] [Shift] $ 

Copy cells  Highlight the cells to copy 

 Click & drag the small square in the lower right 
corner of the highlighted area 

Move cells  Highlight the cells to move 

 Click & drag on any border of the highlighted area 

Create a form quickly  Create the spreadsheet 

 Highlight a cell that will accept input 

 Right-click and select Format Cells… 

 Select the Protection tab 

 Uncheck the Locked checkbox 

 Repeat 
 

 Select Tools, Protection, Protect Sheet… 

 Type in an optional password 

 Click OK 
 
(Excel 2007) 

 Highlight multiple cells using the [Ctrl] key 

 Make sure the first cell to be filled is the last 
selected 

 Type the desired value and press [Enter] 
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Excel 

Tip Technique 

Where should you move 
when you press the 
[Enter] key 

(Excel 2003) 

 Select Tools, Options 

 Select the Edit tab 

 Select your preference for the Move selection after 
Enter 

 Click OK 
 
(Excel 2007) 

 Select the Office Start button  

 Select the Excel Options button  

 Select the Advanced option 

 Enable/Disable After pressing Enter, move 
selection check box 

 Select the Direction drop the drop-down list box 

 Click the OK button 

Auto fill 
Numbers 
 
 
 
Dates 
 
 
Days 
 
 
Months 

 
 
 
Custom list 

 

 Enter first two numbers of sequence 

 Highlight first two cells 

 Copy to end of sequence 
 

 Enter first date 

 Copy to end of sequence 
 

 Enter first day of week 

 Copy to end of sequence 
 

 Enter first month 

 Copy to end of sequence 
 

 Select the Tools, Options… menu 

 Select the Custom Lists tab 

 Type the sequence into the List entries: text box 

 Click the Add button 

Switch sheets in a 
workbook 

Using the keyboard 

 [Ctrl] [PgUp] or [Ctrl] [PgDn] 
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Excel 

Tip Technique 

Enter fractions  Type [0][space] followed by the fraction. 
The fraction will be displayed but the decimal value 
will be stored in the cell. For example “0 1/4” 
displays 1/4 but contains 0.25 

Enter the current date 
and time 

 [Ctrl] ; (semi-colon) for the date 

 [Ctrl] : (colon) for the time 

Quick format number, 
currency, percent, and 
boarder 

 [Ctrl] [Shift] “ for number 

 [Ctrl] [Shift] $ for currency 

 [Ctrl] [Shift] % for percent 

 [Ctrl] [Shift] & for boarder 

Adjust column width or 
row height 

 Highlight the column(s) by selecting the column 
letter(s) at the top of the sheet 

 Make a fixed width adjustment by clicking and 
dragging the column boundary line that follows the 
last column letter 

 Auto fit the column width(s) by double-clicking the 
column boundary line that follows the last column 
letter 

 Apply the same techniques to the horizontal rows 
and row numbers 

Show each open 
spreadsheet on the 
taskbar 

(Excel 2003) 

 Select Tools, Opens 

 On the View tab 

 Check the Windows in taskbar checkbox 

 Click the OK button 
 
(Excel 2007) 

 Select the Office Start button  

 Select the Excel Options button  

 Select the Advanced option 

 Scroll down 

 Check the Show all windows in the taskbar 
checkbox 

 Click the OK button 
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Excel 

Check spelling  [F7] 

Change a setting for the 
whole spreadsheet 

 Select the empty cell above row 1 and to the left of 
column A 
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PowerPoint 

Tip Technique 

Preview while editing  Press [Ctrl] [Shift] [Show]  button 

Change background on 
part of the presentation 

 Select View, Task Pane from the menu 

 Select Slide Design from the Task Pane dropdown 
list 

 Highlight the slides to change 

 Click the dropdown arrow next to the desired 
background from the Task Pane 

 Select Apply to Selected Slides from the menu 

Align objects  Highlight two or more objects on the slide 

 Select the Draw button  on the Drawing 
toolbar often at the bottom left of the screen 

 Select Align or Distribute from the menu 

 Select the desired alignment for the highlighted 
objects 

Nudge objects  Highlight object 

 Press arrow keys to move object 

Hide slide  Right-click slide from the slide preview list 

 Select Hide Slide from the menu 

 Same technique to un-hide slide 

Custom slide sequences  Select Slide Show, Custom Shows… from the 
menu 

 Click the New button 

 Type in the Slide show name: 

 Select and order the slides in the show using the 
Add > >, Remove, and arrow buttons 

 Click OK and then Close when done 

Menu slide with links to 
other slides in the show 

 Right-click object 

 Select Hyperlink from the menu 

 Select Place in this Document from the Link to: list 

 Select the desired “go to” slide or custom show in 
the Select a place in this document: list 

 Click OK 
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PowerPoint 

Tip Technique 

Jump to slide  During the slide show, type slide number to jump 
to and press [Enter] 

Blackout slide  During the slide show, press B 

Whiteout slide  During the slide show, press W 
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Outlook 

Tip Technique 

Sort by multiple columns  Select the column title for the primary sort 

 Hold the [Shift] key and select the column title for 
the secondary sort 

Document cusom flag 
colors or catagories 

Color Flags (Outlook 2003) 

 Create a new toolbar 

 Choose View, Toolbars, Customize 

 On the Toolbars tab, click the New… button 

 Type “Flags” and click OK 

 Drag the Flags toolbar to the toolbar area 
 
Add the Flag buttons 

 Choose Commands 

 Select Actions from the Categories list 

 Drag each flag to the Flags toolbar 
 
Change the name of each flag button 

 Right-click on each flag button 

 Enter the Name: for each flag button 

 Check the Image and Text checkbox option 
 

 Close the Customize dialog box 
 

Color Categories (Outlook 2007) 

 Right-click on a category 

 Choose “All Categories” 

 Manage the categories using the resulting dialog 
box 

Color Catagorize 
Appointments 

(Outlook 2007) 

 Right-click on an appointment 

 Highlight Categorize from the drop down list 

 Choose the desired colored category as defined 
above 

Advanced Search (Outlook 2007) 

 Click the down chevron  to the right of the 
search icon. 
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Outlook 

Instant Task (Outlook 2003) 

 Select a message 

 Drag and drop the message on the Task button 

 Define parameters 

 Click Save and Close toolbar button 
 
(Outlook 2007) 

 Select a message 

 Right-click the flag icon 

 Choose the approximate task date 

Instant Calendar 
Appointment 

(Outlook 2003 & Outlook 2007) 

 Select a message 

 Drag and drop the message on the Task button 

 Define parameters 

 Click Save and Close toolbar button 
 
(Outlook 2007) 

 Go to Calendar 

 Select a task 

 Drag and drop the task on a timeslot 

Message Preview  Choose View, Reading Pane, and desired location 
from the menu 

Attachment Preview (Outlook 2007) 

 In the reading pane preview window, click the 
attachment icon once 

 Click the Preview file button 

Signature Block Selection  Right-click signature block 

 Choose desired signature block 
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Outlook 

Delay Sending a 
Message 

 Choose Tools, Rules & Alerts… menu 

 Click the New Rule… button 

 Under the “Start from a blank rule” category, 
highlight “Check messages after sending” 

 Click the Next> button 

 Check “On this machine only” and click Next> 

 In the “Step 1” list box, check “Defer delivery by a 
number of minutes” 

 In the “Step 2” list box, click “a number of” link 

 Choose a value from 1 to 120 and click OK 

 Click the Finish button 

 Click OK to confirm it is a “client only” rule 

 Click OK again to exit the Rules & Alerts dialog 
box 
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Windows XP, Windows Vista, & Windows 7 

Tip Technique 

Edit Start menu To edit the user’s personal menu: 

 Right-click the Start button 

 Select Explore from the menu 
 
To edit the shared menu: 

 Right-click the Start button 

 Select Explore All Users from the menu 

Send To  Create a shortcut to the target object (printer, 
folder, application, etc.) 

 Highlight the shortcut 

 [Ctrl] X to cut the shortcut 

 Start exploring a particular user or All Users under 
the Documents and Settings folder 

 Go to the SendTo folder 

 [Ctrl] V to paste the shortcut into the SendTo 
folder 

 

 Right-click a document 

 Select the Send To menu 

 Select the Send To target link from the list 

Quick Launch  Right-click an empty portion of the taskbar 

 Select Toolbars, Quick Launch 
 
You can then drag & drop application shortcuts onto 
the Quick Launch toolbar 

Show Desktop 
 Select the Show Desktop button  on the Quick 
Launch toolbar 

Keyboard start of Quick 
Launch applications 

 [Windows key] [number] 
where the number represents the application 
shortcut on the Quick Launch toolbar 

XP / Classic Start menu  Right-click an empty portion of the taskbar 

 Select Properties from the menu 

 Select the Start Menu tab 

 Select the Classic Start Menu radio button 
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Windows XP, Windows Vista, & Windows 7 

Tip Technique 

XP / Classic Control 
Panel 

 Select Start, Control Panel 

 In the left column, click Switch to Classic View 

Hibernate configuration (Windows XP) 

 Select Start, Control Panel 

 Double-click Power Options 

 Select the Hibernate tab 

 Click the Enable hibernation check box 

 Select the Advanced tab 

 Define what should happen when the laptop lid is 
closed, the power button is pressed, and the sleep 
button is pressed 

 Click OK 

Open new window while 
browsing in IE 

 Hold the [Shift] while clicking on the link 

Open new tab while 
browsing in IE 7 

 Hold the [Ctrl] while clicking on the link 

Force IE to remember 
window size 

 [Shift] [Close] 

Access IE menus  Press the [Alt] key 

Remove choices from 
Right-click menu 

 Download TweekUI from www.microsoft.com 

Clean application entries 
from Add or Remove 
control panel 

 Go to technet.microsoft.com 

 Search for knowledge base article 314481 

Minimize all open 
windows 

 [Windows key] [m] 

Display System 
Properties dialog box 

 [Windows key] [Break] 
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Windows XP, Windows Vista, & Windows 7 

Tip Technique 

2D application switch  [Alt] [Tab] 

3D application switch (Windows Vista) 

 [Windows key] [Tab] 

Faster folder access (Windows Vista) 

 Select , Layout, Navigation Pane to 
show the Favorites and Folders panes 

 Select the desired folder 

 Drag & drop the folder into the Favorites pane 

Document preview (Windows Vista) 

 Select , Layout, Preview Pane 

 Select the desired file 

Faster application start (Windows Vista) 

 Click the [Windows pearl]  

 Type in the name of the application in the Search 
text box 

Change [Power]  
button action 

(Windows Vista) 

 Click the [Windows pearl]  

 Type “power” in the Search text box 

 Select Power Options 

 Click any Change plan settings 

 Click Change advanced power settings 

 Expand Power buttons and lid 

 Expand Start menu power button 

 Select the new action from the Setting drop down 
list 

 Click the OK button 
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Windows XP, Windows Vista, & Windows 7 

Screen Snip (Windows Vista) 

 Press [Windows key] [s] 

 Select the portion of the screen to capture 

 This embeds the “snip” into Office OneNote if 
available 

 Switch to the target application 

 Press [Ctrl] [v] 

Desktop Hide / Show (Windows Vista) 

 Press [Windows key] [d] 

Open Explorer Window (Windows Vista) 

 Press [Windows key] [e] 

Customize Explorer 
folder view 

(Windows Vista) 

 Right-click the folder to customize 

 Select Properties 

 Click the Customize tab 

 Select the desired folder type from the folder type 
dropdown list 

 Click the OK button 

Resizing your windows 
(Aero Snap) 

(Windows 7) 

 To dock your window on one half of the screen, 
drag it to the left or right and it will change its size 
to fit that half of the screen 

 To manipulate the vertical size of a window, you 
can drag the window to the top to maximize it, or 
double-click the window’s top or bottom border to 
maximize it vertically while keeping the same 
width 

You can also perform all of these functions with 
keystrokes:  

 [Windows key] [Left arrow] and [Windows key] 
[Right arrow] dock to half the screen  

 [Windows key] [Up arrow] and [Windows key] 
[Down arrow] maximize and minimize  

 [Windows key] [Shift] [Up arrow] and [Windows 
key] [Shift] [Down arrow] maximize and restore 
vertical size 
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Windows XP, Windows Vista, & Windows 7 

Multi-Monitor Window 
Management 

(Windows 7) 

 [Windows key] [Shift] [Left arrow] and 
[Windows key] [Shift] [Right arrow] to move 
windows from one monitor to another 

Project your display (Windows 7) 

 Press [Windows key] [p] and the following pop-up 
window will appear: 

 
 Press your arrow keys or [Windows key] [p] to 
switch through multiple display settings, such as 
“clone”, “extend” or “external only” 

Get rid of all the windows 
behind your active 
window 
(Aero Shake) 

(Windows 7) 

 Click on the title bar and shake the mouse back 
and forth 

You can perform this function with a keystroke 

 Press [Windows key] [Home] 
Repeat the shake or keystroke to restore the 
windows 

Record your keystrokes (Windows 7) 

 Run the Problem Steps Recorder (psr.exe) 

Peek at your desktop 
(Aero Peek) 

(Windows 7) 

 Hover over the button to the right of the Notify 
area 

 
 Move the mouse anywhere to restore the desktop 

 You can minimize all open windows by clicking on 
the peek button 

 Click the peek button again to restore the desktop 
You can perform this function with a keystroke 

 Press [Windows key] [Space] 

 Press [Windows key] [Space] to restore the 
desktop 
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Windows XP, Windows Vista, & Windows 7 

Switch documents within 
an application 

(Windows 7) 

 Press the [Ctrl] and click on the application icon on 
the taskbar 

Pin frequently accessed 
folders to the Windows 
Explorer icon on the 
taskbar 

(Windows 7) 

 Right-click and drag the desired folder to the 
taskbar 

Windows 7 will automatically add the folder to the 
Jump List of the Windows Explorer icon 

 Right-click the Windows Explorer icon on the 
taskbar 

 Select the folder to open 

Open another application 
instance 

(Windows 7) 

 Press the [Shift] and click on the desired 
application on the taskbar 

Sharpen text and adjust 
colors 

(Windows 7) 

 From the Control Panel, search for: 
ClearType Text Tuning 
Display Color Calibration 

Reorder the icons on the 
taskbar 

(Windows 7) 

 Click and drag the icon from one location on the 
taskbar to another 

Launch a taskbar 
application using the 
keyboard 

(Windows 7) 

 Press the [Windows key] and a number from 1 to 
5. The number selects which of the first five 
applications on the taskbar will be opened. 

For the other applications on the taskbar 

 Press [Windows key] [t] to set the focus on the 
taskbar 

 Press the [Right arrow] or [Left arrow] keys to 
select the desired application 

 Press [Enter] to start or set focus on that 
application 
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Sources for this document: 

 Personal experience 

 Microsoft Office and Windows sites 

 PC Magazine & Ziff Davis 

 PACS Membership 

 Jim Powell and the Office Letter (www.officeletter.com) 

 Windows Vista Magazine (www.windowsvistamagazine.com)  

 Office Tips & Tricks Windows Vista gadget 
(http://gallery.live.com/LiveItemDetail.aspx?li=23353790-9689-4ff8-9dc4-
64306756f8fe) 

 Suite101.com 

 Windows 7 Tips & Tricks newsletter 
 
Sign-up for more live Tips & Tricks at www.microsoft.com/office 
 
Watch other Tips & Tricks at Doug Thomas’s Office Casual at 
https://academymobile.microsoft.com/BusinessSeries/office_casual.aspx 
 
Send me your favorite tip, trick, or resource at sdeming@microsoft.com 
 
Steve 
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